# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Description</th>
<th>Page No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Introduction</td>
<td>6</td>
</tr>
<tr>
<td>2. The Architecture</td>
<td>6</td>
</tr>
<tr>
<td>DNAevolution Software Components</td>
<td>6</td>
</tr>
<tr>
<td>DNAevolution Hardware Components</td>
<td>7</td>
</tr>
<tr>
<td>Understanding DNAevolution Archiving, Backup, and Nearline Workflows</td>
<td>7</td>
</tr>
<tr>
<td>Understanding How DNAevolution Writes Data and Metadata</td>
<td>7</td>
</tr>
<tr>
<td>Understanding DNAevolution Data and Command Flow</td>
<td>9</td>
</tr>
<tr>
<td>3. DNAevolution Deployment Options</td>
<td>12</td>
</tr>
<tr>
<td>Deployment 1: Direct-Mount Linux Server Deployment</td>
<td>12</td>
</tr>
<tr>
<td>Deployment 2: Direct-Mount Mac Server Deployment</td>
<td>13</td>
</tr>
<tr>
<td>Deployment 4: Direct-Mount Mac Virtual Server Deployment</td>
<td>14</td>
</tr>
<tr>
<td>4. Pre-Install Checklist</td>
<td>15</td>
</tr>
<tr>
<td>Rack space</td>
<td>15</td>
</tr>
<tr>
<td>Static IP address</td>
<td>15</td>
</tr>
<tr>
<td>Bar code labeled LTO tapes</td>
<td>15</td>
</tr>
<tr>
<td>X Series Linux archive manager considerations</td>
<td>15</td>
</tr>
<tr>
<td>N Series Linux archive manager considerations</td>
<td>15</td>
</tr>
<tr>
<td>Mac archive manager considerations</td>
<td>16</td>
</tr>
<tr>
<td>5. Hardware Install and Configuration</td>
<td>16</td>
</tr>
<tr>
<td>X100, X200 Linux Controller/Linux Archive Manager Hardware Setup (for Deployments 1 and 2)</td>
<td>16</td>
</tr>
<tr>
<td>X100, X200 Linux Controller/Mac Archive Manager Hardware Setup (for Deployment 3)</td>
<td>17</td>
</tr>
<tr>
<td>X100-24, X200-24, X200-48, X400-28 Linux Controller/Linux Archive Manager Hardware Setup (for Deployments 1 and 2)</td>
<td>19</td>
</tr>
<tr>
<td>X100-24, X200-24, X200-48, X400-28 Linux Controller/Mac Archive Manager Hardware Setup (for Deployment 3)</td>
<td>20</td>
</tr>
<tr>
<td>Mac Virtual Server, Mac Archive Manager Setup (for Deployment 4)</td>
<td>21</td>
</tr>
</tbody>
</table>
### TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Description</th>
<th>Page No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>6. Software Install, Power-On</td>
<td>22</td>
</tr>
<tr>
<td>DNAevolution Controller Setup</td>
<td>22</td>
</tr>
<tr>
<td>Determining DNAevolution Version</td>
<td>23</td>
</tr>
<tr>
<td>DNAevolution Linux Archive Manager Setup</td>
<td>24</td>
</tr>
<tr>
<td>DNAevolution Mac Virtual Controller Setup</td>
<td>24</td>
</tr>
<tr>
<td>DNAevolution Mac Archive Manager Setup</td>
<td>25</td>
</tr>
<tr>
<td>7. The Administrator Dropbox</td>
<td>26</td>
</tr>
<tr>
<td>8. AccessDNA</td>
<td>27</td>
</tr>
<tr>
<td>Getting to AccessDNA</td>
<td>27</td>
</tr>
<tr>
<td>Enable Folder Access</td>
<td>28</td>
</tr>
<tr>
<td>Enable UNC Drives</td>
<td>28</td>
</tr>
<tr>
<td>View and Restart Services</td>
<td>28</td>
</tr>
<tr>
<td>Enable Client Logging</td>
<td>28</td>
</tr>
<tr>
<td>9. Configuration and System Settings</td>
<td>29</td>
</tr>
<tr>
<td>Configuring Previews</td>
<td>29</td>
</tr>
<tr>
<td>Mounting Network Shares</td>
<td>31</td>
</tr>
<tr>
<td>Configuring Catalog Backups</td>
<td>31</td>
</tr>
<tr>
<td>Configuring Email</td>
<td>32</td>
</tr>
<tr>
<td>Create, Edit, Preview Metadata Tagging Templates</td>
<td>32</td>
</tr>
<tr>
<td>Normal and limited user Metadata Tagging</td>
<td>33</td>
</tr>
<tr>
<td>Setup Automated Preview Creation</td>
<td>34</td>
</tr>
<tr>
<td>Manually Indexing Previews</td>
<td>34</td>
</tr>
<tr>
<td>10. LTO/LTFS Tape Management</td>
<td>35</td>
</tr>
<tr>
<td>LOADER LOCK (Autoloaders only)</td>
<td>35</td>
</tr>
<tr>
<td>MOUNT, UNMOUNT</td>
<td>35</td>
</tr>
<tr>
<td>MOVE (Autoloaders only)</td>
<td>36</td>
</tr>
<tr>
<td>Format Tapes</td>
<td>36</td>
</tr>
</tbody>
</table>
## TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manually Verify Tapes</td>
<td>38</td>
</tr>
<tr>
<td>Auto Verify Tapes</td>
<td>41</td>
</tr>
<tr>
<td>Duplicating Tapes</td>
<td>42</td>
</tr>
<tr>
<td>Importing Tapes</td>
<td>45</td>
</tr>
<tr>
<td>Viewing Tapes and Utilization, Adding Notes</td>
<td>48</td>
</tr>
<tr>
<td>Deleting Tapes</td>
<td>49</td>
</tr>
<tr>
<td>Generating Reports</td>
<td>49</td>
</tr>
<tr>
<td>Viewing Reports</td>
<td>51</td>
</tr>
<tr>
<td>12. Archive Managers and Servers Management</td>
<td>52</td>
</tr>
<tr>
<td>The Clients View</td>
<td>52</td>
</tr>
<tr>
<td>General Information</td>
<td>52</td>
</tr>
<tr>
<td>Point-to-Point Connectivity</td>
<td>53</td>
</tr>
<tr>
<td>Tape Devices</td>
<td>53</td>
</tr>
<tr>
<td>13. Users and Groups Tabs Reference Guide</td>
<td>54</td>
</tr>
<tr>
<td>Adding, Editing, Deleting Users</td>
<td>54</td>
</tr>
<tr>
<td>Adding, Editing Groups</td>
<td>55</td>
</tr>
<tr>
<td>Normal User Workflow</td>
<td>55</td>
</tr>
<tr>
<td>Group Workflow</td>
<td>56</td>
</tr>
<tr>
<td>14. License Management</td>
<td>57</td>
</tr>
<tr>
<td>License Usage and Policy</td>
<td>57</td>
</tr>
<tr>
<td>License Listing</td>
<td>57</td>
</tr>
<tr>
<td>To Add a User to a Machine</td>
<td>57</td>
</tr>
<tr>
<td>To Remove/Uninstall a Client Machine and Reclaim the License</td>
<td>57</td>
</tr>
<tr>
<td>15. Upgrading DNAevolution Controller, Archive Manager, Archive Client</td>
<td>58</td>
</tr>
<tr>
<td>Upgrading DNAevolution Controller and Linux Archive Manager</td>
<td>58</td>
</tr>
<tr>
<td>Upgrading Archive Manager and Archive Client</td>
<td>59</td>
</tr>
<tr>
<td>16. Catalog Management</td>
<td>60</td>
</tr>
<tr>
<td>Importing and Exporting Archives via XML</td>
<td>60</td>
</tr>
</tbody>
</table>
# TABLE OF CONTENTS

17. SYSTEM MONITORING .................................................................................................................. 63
   Introduction ................................................................................................................................. 63
   Viewing Live System Statistics ................................................................................................. 63
   See running processes (CURRENT or AT A PREVIOUS POINT IN TIME) ................................ 63
   See Detailed process view, INSTALLED SW AND CONNECTED DEVICES ................................ 64
   See System LOAD ...................................................................................................................... 65
   See Running Processes ............................................................................................................. 65
   See DISK Statistics .................................................................................................................... 65
   See MEMORY STATISTICS ......................................................................................................... 65
   See CPU Utilization .................................................................................................................. 65

18. SYSTEM LOGGING ...................................................................................................................... 66
   Introduction ................................................................................................................................. 66
   ENABLING SYSTEM LOGGING ................................................................................................. 66
   Viewing SYSTEM Logs ............................................................................................................. 67
   ALERTS DASHBOARD .................................................................................................................. 69
The DNAevolution Controller is software that runs on a networked Linux appliance. This software can run on a physical server (X Series, N Series) or on a virtual server (M Series). This core software component is included in all DNAevolution products and is the core of the solution. The appliance running the controller resides on the network and provides overall management and policy functions to the rest of the DNAevolution environment. The controller itself does not transfer data, but instead manages the traffic of all data transfers.

It provides an interface for:
+ Setup and administration of archives and jobs
+ User and group management
+ Client machine management

Additionally, it stores all policy information regarding a DNAevolution environment (archive policies, user policies, group policies, and reporting).

The DNAevolution Archive Manager is software that runs either on the Linux appliance or on a Mac system, based on customer environment and workflow requirements. (Currently, there is no Archive Manager for Microsoft Windows. However, archiving from Windows machines is supported via the archive client described in the next section). The Archive Manager is the module responsible for interfacing with the LTO tape hardware and negotiating access to it for the different client software components. It can archive and restore data over directly connected sources on the machine it is installed on (e.g., local volumes mounted via direct attached NAS or SAN storage), or it can run in a networked mode, (e.g., on the Linux appliance), where it receives data from multiple networked archive clients.

The DNAevolution Client is a lightweight background application that is installed directly onto a laptop, desktop, or server. It is designed to perform network-based transfers and runs natively on a number of host operating systems, including Mac, Linux, and Windows. The client is responsible for performing transfers and can perform archive and restores to and from an Archive Manager. The workstation that the client software is installed on connects to various storage systems (local, SAN, NAS, etc.) and acts as the gateway for archive and restore. It transfers data to LTO tape via the archive manager over an intermediate network connection. All information about how to perform the transfer is fetched from the controller, and subsequent information about the transfer, such as, job progress and status, is stored on the controller.
DNAEVOLUTION LINUX APPLIANCE

The DNAevolution Linux appliance is a hardware appliance that is included in almost all DNAevolution installs (X and N Series). For the M series, the DNAevolution Controller Software can exist on a customer-provided Mac. As an option, the Linux hardware appliance included in the X and N Series can be configured to host the DNAevolution archive manager in certain deployments.

TAPE HARDWARE

Most DNAevolution solutions also include LTO tape hardware (X and M series). The tape hardware is hosted on a system that hosts the archive manager. Therefore, in certain deployments, it can be hosted on the Linux appliance or connected to a Mac archive manager.

UNDERSTANDING DNAEVOLUTION ARCHIVING, BACKUP, AND NEARLINE WORKFLOWS

DNAevolution allows you to move data from your primary storage to an LTO/LTFS storage tier. The following list highlights the key differences between archiving, backup, and nearline workflows:

+ Archiving: Archiving refers to the long-term archival of media. Media that is archived in today’s modern file-based workflows includes raw footage from file-based cameras, media related to finished projects, and final exports.
+ Backup: Backup, on the other hand, is performed to protect your active work-in-progress media. This is done largely to recover quickly from a data loss event, such as a storage failure, operator error, or a virus. Backed-up data may often not be archived at all after a project is completed.
+ Nearline: As media pipelines deal with higher resolution data, it is not feasible to keep all data online. DNAevolution enables seamless migration by which content can be migrated and deleted safely from your online storage and retrieved or accessed directly (via LTFS) when needed.

UNDERSTANDING HOW DNAEVOLUTION WRITES DATA AND METADATA

DNAevolution follows a policy of “open data” and “open metadata”. All data is written to LTO (via LTFS) in an open, readily accessible format. Metadata is written to an XML file system, enabling an end user to easily update or extract this information.
DNAevolution maintains two XML databases. These can be found in Shared Folders (under Catalogs) for the Mac-based controller (M Series) or in /sdna_fs/PROXIES/ for the Linux controller (X and N Series). For each archive, you will see a folder that matches the archive name. Under each archive name, you will see two folders named “1” and “metadata”.

The “1” folder maintains a file-system view that matches the Browse Files view in the web interface. This serves as the file-system metadata index and catalog. Each filename and directory structure is preserved. However each file (though retaining the same name as the source) is an XML file representing the original file. (See following screenshot)
As seen in the screenshot above, the details with the location LTO, LTO bar code, and checksum are stored in an open XML format.

DNAevolution includes a media asset management (MAM) engine that extracts metadata and derives clip information for over 180 file formats. The clip and extracted metadata are stored per archive in an open XML file system.

A sample is the following:

```
<k:clip typeid="mov" type="QuickTime" clipid="77793827a831092d281ed5a6fc7bb4cc" name="2013-08-27-RawMedia-MAM" media-path="[[CDATA[/Users/tc/Movies/V3.0-Demos]]]">
  <meta-data>
    <d:name="Audio Bits Per Sample">16</d:name>
    <d:name="Audio Channels">2</d:name>
    <d:name="Audio Format">Linear PCM</d:name>
    <d:name="Audio Sample Rate">44100</d:name>
    <d:name="Avg Bitrate">12.59 Mbp/s</d:name>
    <d:name="Balance">0.0</d:name>
    <d:name="Bit Depth">24</d:name>
    <d:name="Clean Aperture Dimensions">1440x900</d:name>
    <d:name="Compatible Brands">8</d:name>
    <d:name="Compressor ID">1</d:name>
    <d:name="Compressor Name">H.264</d:name>
    <d:name="Create Date">2013-08-28 03:16:27</d:name>
    <d:name="Creation Date">2013-08-27 20:07:49-07:00</d:name>
  </meta-data>
</k:clip>
```

DNAevolution can derive single file/self-contained clips (e.g. .mov, .mp4) as well as multi-file clips such as Avid Mediafiles, P2, XDCAM, ARRI, and more. For a complete list of supported clips and formats, refer to document “DNAevolution v3.5: Format Support”.
This section includes information about how the controller, archive managers, and archive clients interact to move data. In addition, details include how data and metadata travel across the various components. An example of a network archive and a local archive are featured in the diagram pictured in the next screenshot.
STEP 1: CREATING AND SAVING A JOB

The first step is for you to create and save a job via the web interface. When a job is saved, it is stored on the controller in its policy database. The process of creating a job involves choosing a “source” and “target”, which can vary depending on the specific configuration and environment. In general, users need to pick the <archive client machine OR archive manager w/ source directories> AND <archive manager machine/target archive> pair. If an Archive Client is picked as the source and Archive Manager as the target, it is defined as a network transfer job. If an Archive Manager is picked as source and target, then it is a local transfer job. Additional options can be selected, including policies and filters, among others. DNAevolution automatically manages the target hardware without end user intervention.

STEP 2: JOB START

An archive job can be scheduled to start automatically or run manually via clicking the “start” button in the web interface, or may be executed by a third-party through scripting. When an archive job starts, a process is spawned. The process first contacts the controller’s web services, as it has no information locally stored about the job. The process retrieves the source directory, target archive and job run policies, from the controller’s web services. After this step, the process can start archiving or restoring content.

ARCHIVING VIA FOLDERS OR TICKETS

DNAevolution allows you to either select folders for archiving, or archive via an exported tickets representing the content that is converted into a DNAevolution ticket. When a ticket is used for archiving, only media referenced within the ticket is archived.

STEP 3: ARCHIVE JOB RUN

The process will perform a local archive if an <archive manager, archive manager> pair has been specified and will perform a network archive if an <archive client, archive manager> pair has been specified during job creation.

The process then will contact the Archive Manager, (locally or over the network), that was selected for archiving. The Archive Manager first looks for available tape hardware. The system may use standalone tape drives or an autoloader. In both cases, the archive manager will look for a free tape drive. If a free tape drive is not found, the job will fail and return with a “device not available” error. The job will retry when it is manually run again. On the other hand, if it finds a free drive, it will check to see if a valid tape is loaded (a valid tape is one that has been assigned to the archive). If a valid tape is not loaded, it will attempt to load a valid tape for the archive (if it is an autoloader). If a valid tape is not found in the slots of the autoloader, or if the standalone tape drive does not contain a valid tape, the client sends an error to the controller, requesting the end user to load the appropriate tape (NOTE: Email notification must be enabled to receive notifications for tape changes).

If the archive manager finds a free drive that can load an appropriate tape, it makes the tape available for writing. At this point, the process is ready to start archiving data. Source data can be local or accessed via a network share. Data can be archived locally to available hardware, if the archive is run directly on the archive manager, or archived over the network to an archive manager. In either case, data is archived “direct-to-tape” without any intermediate caching. DNAevolution utilizes the ability of LTO technology to checksum and perform writes at the same time in one operation.
Before files are written to tape, the process compares the list of files it needs to archive with the files that have already been archived, as part of this archive. To do so, it compares the source file name, size, and modified time against the target.

**NOTE:** DNAevolution compares files in the source and target and only makes incremental copies. It performs this check based on the location of the file and the file size, modified date.

In all cases, the archiving process on the archive client or manager will send progress and other information to the controller’s web services. Information it sends to the controller includes XML files describing the file system (enabling web browse and search). During archiving, the archiving process can extract additional metadata/file information. In addition to XML information, the archiving process can provide a low-res previews folder. The archiving process also correlates file names, enabling web-based preview play. Additionally, DNAevolution can create links of files successfully archived for purposes of preview creation and other tasks.

**STEP 4: WEB BROWSE, SEARCH, AND PREVIEW**

After a job has run, and related metadata has been synced to the controller, you can browse, search, and preview your archived data via the web interface. DNAevolution presents a single global view of all data that is archived.

**STEP 5: FOLDER OR TICKET RESTORE**

You can select files to restore directly via browsing or searching within the DNAevolution web-based interface. Files selected for restore can be restored back to their original location or to a new location. When a restore is initiated, the restore process retrieves job information from the Controller, much like an archive job, and processes files in the restore list.

In addition to folder-based restores, DNAevolution enables restores via tickets. An exported ticket (AAF/XML/EDL/ALE) can be provided to DNAevolution as a restore list. DNAevolution interprets the restore list and performs a search against its archive and finds the tapes that the referenced files reside on. It then gathers the original media and restores it to a desired location based on job definition. In addition, DNAevolution can also be used to perform a “fuzzy” match, in which it uses the original “online” files referenced in the exported AAF/XML/EDL/ALE as a clue to find the source media residing on tape. This is relevant in an offline/online scenario in which media needs to be conformed from LTO.
With DNAevolution systems, there is flexibility in how they can be deployed. This chapter provides information about deployment options and covers the pros and cons of each option.

For every configuration, any highlights in the configuration are shown in red.

### DEPLOYMENT 1: DIRECT-MOUNT LINUX SERVER DEPLOYMENT

In this deployment, the Linux server hosts both the controller and the archive manager. Data is pulled directly from the Linux archive manager by mounting network shares (NFS/Samba) or by installing a SAN client on the Linux archive manager (e.g., Quantum StorNext client).

#### Description
In this deployment, the Linux server hosts both the controller and the archive manager. Data is pulled directly from the Linux archive manager by mounting network shares (NFS/Samba) or by installing a SAN client on the Linux archive manager (e.g., Quantum StorNext client).

#### Valid DNAevolution Systems
Valid for all DNAevolution systems except M Series

#### Known Limitations
None

#### System Requirements
Refer to DNAevolution System Requirements Document
Description
In this deployment, the Linux appliance hosts the controller software, and the
Mac acts as the archive manager. The Mac also connects to end-user storage,
and data transfers happen directly over SAS—without any network limitations.

Valid DNAevolution Systems
Valid for all DNAevolution systems except M Series

System Requirements
Refer to DNAevolution System Requirements Document
**DEPLOYMENT 4: DIRECT-MOUNT MAC VIRTUAL SERVER DEPLOYMENT**

In this deployment, a Mac-based system hosts the controller software (as a virtual machine), and the Mac also acts as the archive manager. The Mac also connects to end-user storage, and data transfers happen directly over SAS—without any network limitations.

### Description

In this deployment, a Mac-based system hosts the controller software (as a virtual machine), and the Mac also acts as the archive manager. The Mac also connects to end-user storage, and data transfers happen directly over SAS—without any network limitations.

### Valid DNAevolution Systems

Valid only for M Series

### Known Limitations

Additional DNAevolution clients not supported

### System Requirements

Refer to DNAevolution System Requirements Document
**PRE-INSTALL CHECKLIST**

The following checklist applies to the following DNAevolution products: X100, X200, X100-8, X100-24, X200-24, X200-48, X400-48, N100.

Refer to the “DNAevolution M100/VM: Install and Setup Guide” for Mac-based configurations.

Before your hardware and software is deployed, please ensure the following:

### RACK SPACE

- X100 (2u) + Additional rack space for Mac archive manager (if configuring)
- X200 (2u) + Additional rack space for Mac archive manager (if configuring)
- X100-8 (2u) + Additional rack space for Mac archive manager (if configuring)
- X100-24 (3u) + Additional rack space for Mac archive manager (if configuring)
- X200-24 (3u) + Additional rack space for Mac archive manager (if configuring)
- X200-48 (5u) + Additional rack space for Mac archive manager (if configuring)
- X400-48 (5u) + Additional rack space for Mac archive manager (if configuring)
- N100 (1u for N100) + Additional rack space for Mac archive manager (if configuring)
- + Additional rack space for customer LTO hardware

### STATIC IP ADDRESS

- The DNA Controller needs a static IP address and must be allocated prior to setup

### BAR CODE LABELED LTO TAPES

- Ensure that prior to setup you have at least one bar code labeled LTO tape. LTO tapes must be bar code labeled in both single drive and autoloader deployments.
- All bar codes must be professionally printed with no duplicate ID/Names.

### X SERIES LINUX ARCHIVE MANAGER CONSIDERATIONS

- The Linux archive manager is pre-installed on the Linux server that also hosts the controller. In this case, the Linux server will be connected via SAS to the LTO hardware. All LTO hardware ships with 2m SAS cables and rack mount placement should be accounted for.

### N SERIES LINUX ARCHIVE MANAGER CONSIDERATIONS

- The Linux archive manager is pre-installed on the Linux server that also hosts the controller. In this case, the Linux server will be connected via SAS or FC to the customer provided LTO hardware. Please ensure that the appropriate and supported HBA cards, connectivity and cables are provided for connecting the N100 server to the existing LTO hardware. Please contact StorageDNA for latest information on supported third-party libraries.
MAC ARCHIVE MANAGER CONSIDERATIONS:
+ The Archive Manager can also be hosted on a separate Mac while the Linux controller acts as a standalone controller.
+ In this case, ensure that the customer provided Mac is racked and is equipped with the proper cards, cables and connectivity to the LTO hardware.

HARDWARE INSTALL AND CONFIGURATION
The following section includes hardware installation guides for each DNAevolution model.

X100, X200 LINUX CONTROLLER/LINUX ARCHIVE MANAGER HARDWARE SETUP (FOR DEPLOYMENTS 1 AND 2)

This section assumes you have completed the pre-install steps before hardware setup

STEP 1:
+ Review the checklist of hardware components:
  (A) HP DL120/320/380 Rack-Mount Server (Box 1)
  (B) 2 m mini-SAS to mini-SAS connector OR 4 m external mini-SAS fan-out cable (Box 1)
  (C) HP 1U Rack-Mount SAS Enclosure w/1 or 2 x HH LTO Tape Drive (Box 2)
  (D) Rack-Mount Kit for SAS Enclosure (Box 2)
  (E) StorageDNA USB Key for Auto-Backups

STEP 2:
+ Unpack your HP DL120/320/380 server (A). Use the HP DL120/320/380 instructions to rack your server.

STEP 3:
+ Unpack your 1U SAS tape rack-mount kit (C). The rack-mount kit will be prepopulated with your HP LTO half-height tape drive. Use the SAS tape rack-mount enclosure instructions to rack the enclosure.

STEP 4:
+ Connect the SAS cable (B) from the HP DL120/320/380 (A) to the internal tape drive in the HP 1U rack-mount kit (C).

STEP 5:
+ Connect power cords to both the server (DL120/320/380) (A) and the tape rack-mount enclosure (C).

STEP 6:
+ Connect the network to the DL120/320/380 (A). You will also need to connect a keyboard, monitor, and mouse to your system for setup. Remember to plug the USB key (E) into an open USB slot.
STEP 7:
+ Power the system on in the following sequence:
  • Tape rack-mount enclosure (C)
  • DL120/320/380 (A)

STEP 8:
+ Upon boot-up, log in using the following credentials:
  • Username: root
  • Password: dna180

STEP 9:
+ Refer to Chapter 6, "Software Install, Power-On," of this user guide for next steps.

X100, X200 LINUX CONTROLLER/ MAC ARCHIVE MANAGER HARDWARE SETUP
(FOR DEPLOYMENT 3)

This section assumes you have completed the pre-install steps before hardware setup

STEP 1:
+ Review the checklist of hardware components:
  (A) HP DL120/320/380 Rack-Mount Server (Box 1)
  (B) 2 m mini-SAS to mini-SAS connector OR 4 m external mini-SAS fan-out cable (Box 1)
  (C) HP 1U Rack-Mount SAS Enclosure w/1 or 2 x HH LTO Tape Drive (Box 2)
  (D) Rack-Mount Kit for SAS Enclosure (Box 2)
  (E) StorageDNA USB Key for Auto-Backups
  (F) Atto H644 SAS Card
  Additionally, you must have a Mac Pro to host the Atto H644 card.
  (G) Mac Pro with free PCI-E slot for Atto H644 card

STEP 2:
+ Unpack your HP DL120/320/380 server (A). Use the HP DL120/320/380 instructions to rack your server.

STEP 3:
+ Unpack your 1U SAS tape rack-mount kit (C). The rack-mount kit will be prepopulated with your HP LTO half-height tape drive. Use the SAS tape rack-mount enclosure instructions to rack the enclosure.

STEP 4:
+ Power down the Mac Pro (G). Install the Atto H644 card in the Mac Pro's free PCI-E slot.
STEP 5:
+ Connect the SAS cable (B) from the Mac Pro (G) to the internal tape drive in the HP 1U rack-mount kit (C).

STEP 6:
+ Connect power cords to both the server (DL120/320/380) (A) and the tape rack-mount enclosure (C).

STEP 7:
+ Connect the network to the DL120/320/380 (A). You also will need to connect a keyboard, monitor, and mouse to your system for setup. Remember to plug the USB key (E) into an open USB slot.

STEP 8:
+ Power the system on in the following sequence:
  • Tape rack-mount enclosure (C)
  • Mac Pro (G)
  • DL120/320/380 (A)

STEP 9:
+ Upon boot-up, log in using the following credentials:
  • Username: root
  • Password: dna180

STEP 10:
+ Refer to Chapter 6, “Software Install, Power-On,” of this user guide for next steps.
This section assumes you have completed the pre-install steps before hardware setup

STEP 1:
+ Review the checklist of hardware components:
  (A) HP DL120/320/380 Rack-Mount Server (Box 1)
  (B) 2 m mini-SAS to mini-SAS connector OR 4 m external mini-SAS fan-out cable (Box 2)
  (C) HP 1U/2U/4U Rack-Mount Autoloader w/1/2/4 x HH LTO Tape Drive (Box 2)
  (D) Rack-Mount Kit for LTO Autoloader (Box 3)
  (E) StorageDNA USB Key for Auto-Backups (Box 1)

STEP 2:
+ Unpack your HP DL120/320/380 server (A). Use the HP DL120/320/380 instructions to rack your server.

STEP 3:
+ Unpack your 1U/2U/4U SAS LTO Autoloader Kit (C). The autoloader will be prepopulated with your HP LTO half-height tape drive(s). Use the SAS tape rack-mount instructions to rack the enclosure.

STEP 4:
+ Connect the SAS cable (B) from the HP DL120/320/380 (A) to the tape drive(s) in the HP Autoloader (C). The SAS connections are in the rear. For X200/X400 Series systems with fan-out cables, ensure that the cable with label SAS0 is connected to the bottommost drive.

STEP 5:
+ Connect power cords to both the server (DL120/320/380) (A) and the tape autoloader (C).

STEP 6:
+ Connect the network to the DL120/320/380 (A). You also will need to connect a keyboard, monitor, and mouse to your system for setup. Remember to plug the USB key (E) into an open USB slot.

STEP 7:
+ Power the system on in the following sequence:
  • Tape autoloader (C)—The display should state that all drives are RDY.
  • DL120/320/380 (A)

STEP 8:
+ Upon boot-up, log in using the following credentials:
  • Username: root
  • Password: dna180
STEP 9:
+ Refer to Chapter 6, “Software Install, Power-On,” of this user guide for next steps.

X100-24, X200-24, X200-48, X400-28 LINUX CONTROLLER/MAC ARCHIVE MANAGER HARDWARE SETUP (FOR DEPLOYMENT 3)

STEP 1:
+ Review the checklist of hardware components:
  (A) HP DL120/320/380 Rack-Mount Server (Box 1)
  (B) 2 m mini-SAS to mini-SAS connector OR 4 m external mini-SAS fan-out cable (Box 2)
  (C) HP 1U/2U/4U Rack-Mount Autoloader w/1/2/4 x HH LTO Tape Drive (Box 2)
  (D) Rack-Mount Kit for LTO Autoloader (Box 3)
  (E) StorageDNA USB Key for Auto-Backups (Box 1)
  (F) Atto H644 SAS Card (If hosting on old Mac Pro) OR mLogic mBridge Thunderbolt to SAS adapter (If hosting on new Mac Pro, Mac Mini or MacBook)
  (G) Mac Pro with free PCI-E slot for Atto H644 card OR new Mac Pro, Mac Mini, MacBook with a free Thunderbolt port

STEP 2:
+ Unpack your HP DL120/320/380 server (A). Use the HP DL120/320/380 instructions to rack your server.

STEP 3:
+ Unpack your 1U/2U/4U SAS LTO Autoloader Kit (C). The autoloader will be prepopulated with your HP LTO half-height tape drive(s). Use the SAS tape rack-mount instructions to rack the enclosure.

STEP 4:
+ Power down the Mac (G). Install the Atto H644 card in the old Mac Pro’s free PCI-E slot OR Connect the Thunderbolt cable between the new Mac Pro, Mac Mini, MacBook and the mLogic mBridge Box.

STEP 5:
+ Connect the SAS cable (B) from the old Mac Pro (G) to the tape drive(s) in the HP Autoloader (C) OR connect the SAS cable from the mLogic mBridge Box to the tape drive(s) in the HP Autoloader (C). The SAS connections are in the rear. For X200/X400 Series systems with fan-out cables, ensure that the cable with label SAS0 is connected to the bottommost drive.

STEP 6:
+ Connect power cords to both the server (DL120/320/380) (A) and the tape autoloader (C).
STEP 7:
+ Connect the network to the DL120/320/380 (A). You also will need to connect a keyboard, monitor, and mouse to your system for setup. Remember to plug the USB key (E) into an open USB slot.

STEP 8:
+ Power the system on in the following sequence:
  • Tape autoloader (C)—The display should state that all drives are RDY.
  • Mac Pro (G)
  • DL120/320/380 (A)

STEP 9:
+ Upon boot-up, log in using the following credentials:
  • Username: root
  • Password: dna180

STEP 10:
+ Refer to Chapter 6, “Software Install, Power-On,” of this user guide for next steps.

MAC VIRTUAL SERVER, MAC ARCHIVE MANAGER SETUP
(FOR DEPLOYMENT 4)

The setup for the Mac Virtual System is covered in a separate document “DNAevolution M100: Install and Setup Guide”. 
This section includes the steps for configuring, installing software modules into, and powering on a DNAevolution system.

DNAEVOLUTION CONTROLLER SETUP

The DNAevolution Linux appliance (HP DL120/320/380) is included with all DNAevolution systems: X100, X100-8, etc. In this section, we guide you through the steps needed to power on and initial setup of the HP Linux server and controller.

Please refer to the hardware setup guides (racking, power, etc.) for each system in the previous section before powering on the system

Power on and setup steps for the Mac Virtual Server are similar but details are covered in document “DNAevolution M100 Install and Setup Guide”

After first power-on, the following section will guide you through the steps necessary to ensure your system is ready to go:

- Check your IP address.
- If needed, set a static address.
- Ensure all tape hardware is configured and visible.
- Ensure all processes are running.

LOG IN

After power-on, you can log in to the server using the following default credentials:

- Username: root
- Password: dna180

You then will be guided to the CentOS desktop. On the desktop, you will find a number of scripts designed to help you get started (see next screenshot).
CHECK IP ADDRESS
The script named “display-network” will display all Ethernet ports and their IP addresses.

SET UP STATIC IP ADDRESS
To configure a static IP address, run the script “configure network”. This will invoke the Centos Ethernet settings screen. Follow these steps:

+ Click on the adapter you want to configure (Default should be eth0).
+ Click on Edit.
+ Select “Statically set IP address.”
+ Provide IP address, gateway, and subnet mask.
+ Remember to save (File->Save).
+ Also, select the adapter and inactivate and reactivate the network.

ENSURE ALL PROCESSES ARE RUNNING
Run script “check-services” to ensure all DNAevolution processes are running successfully. Normally, you should see the following:
GOOD: Web Server is running
GOOD: Database is running
GOOD: LDAP is running
GOOD: Samba shares are running
GOOD: SDNA Daemon is running
GOOD: DNA Client Service Provider is running
GOOD: DNA Client Proxy is running
GOOD: Fuse module is loaded
GOOD: Logger is running and listening on 9094
GOOD: SDNAServerProxy is running and listening on 4545
GOOD: SDNAServerProxy is running and listening on 4545

DETERMINING DNAEVOLUTION VERSION
To determine the current version of the software, refer to the version and build number in the footer of any of the pages including My Archives screen. (See next screenshot)
DNAEVOLUTION LINUX ARCHIVE MANAGER SETUP

If you are connecting the tape hardware directly to a Mac, then skip this step

Since the tape hardware can be connected to the supplied HP Linux server, this section guides you through the steps needed to ensure the hardware is connected and visible.

On the Linux controller desktop, run the script “check-tapehardware” to ensure all expected hardware is connected. For all systems, based on the number of tape drives, you should see the following for each drive:

+ Vendor: HP
+ Model: Ultrium 6-SCSI
+ Rev: Z39W
+ Type: Sequential-Access
+ ANSI SCSI revision: 06

For automation units (X100-8, X200-24, X200-48, X400-48), you also should see the automation component shown as:
+ Vendor: HP
+ Model: MSL G3 Series
+ Rev: E.02
+ Type: Medium Changer
+ ANSI SCSI revision: 05

You can't see the tape hardware? Check if your tape drive is powered on, and make sure all cables are properly connected

DNAEVOLUTION MAC VIRTUAL CONTROLLER SETUP

Software install and power-on steps for the Mac Virtual Controller are included in another document “DNAevolution M100: Install and Setup Guide”. 
DNAEVOLUTION MAC ARCHIVE MANAGER SETUP

It is possible to configure a Mac Pro (pre-Trash Can version) as an archive manager as an alternative to using the Linux appliance for this purpose. This section will guide you through the software setup required prior to installation of the Mac archive manager and the installation steps involved for the Mac archive manager software components.

INSTALL THE ATTO DRIVERS
Install the proper ATTO drivers for the associated SAS or Fibre Channel HBA to ensure you can see the attached tape hardware. Please refer to the ATTO website for downloading and instructions on firmware and driver setup.
Once the driver is installed, you should ensure that you have powered on the tape hardware and that the tape hardware is visible.

INSTALL LTFS
Install the HP or IBM Mac OS X LTFS drivers included in the package.

DNAEVOLUTION MAC ARCHIVE MANAGER INSTALLATION
After following the previous steps, you can begin your DNAevolution archive manager installation and setup.

STEP 1: Download the DNAevolution client/archive manager.
The client can be downloaded directly from the DNAevolution web interface. In the Job Listing pane under My Archives, select the Client Installers icon. Download the Mac version to your local desktop.

STEP 2: Installation
After you agree to the End User License Agreement, you will need to provide the following information:

1. DNAevolution Server
IP address: Provide the IP address of the DNAevolution Server configured in Section: DNAevolution Controller Setup.
OR
Hostname: Alternatively, you can provide "dnaserver" as the hostname.

2. A valid license key
Provide a valid archive manager license key, and, if accurate, it will proceed to the next screen of the wizard. In this screen, you can provide a client machine identifier. This defaults to the hostname of the machine, but you can change that to an alternate name at this time. Note that this name is not used for network connectivity and is for identification and labeling purposes only.
You can click through the next few screens, and the installer will complete the process.

TIP: Where can you find your license keys? Go to the Clients tab -> License Management, and pick any license highlighted in green. Please ensure you pick a Mac Archive Manager License key with the appropriate number of tape drives.
STEP 3: Set up AccessDNA
The installer will launch AccessDNA automatically after installation is complete. AccessDNA is an application that allows you to set rules on which folders you want exposed to the DNAevolution web interface for user access. These rules can be set up for global users or based on individual users. Once a folder is exposed, a user with access to the web console can create jobs to and from the client system automatically.

Please refer to the AccessDNA section for information on how to properly configure AccessDNA.

**TIP:** If you do not save your settings in AccessDNA, your settings will not take effect.

---

**THE ADMINISTRATOR DROPBOX**

The administrator dropbox is a useful location on the controller that stores logs, reports and other detailed information. It can be accessed via the web interface but can also be accessed over the network. Any system with connectivity to the controller can connect to the administrator dropbox directly.

---

**WINDOWS:** To access the administrator dropbox over the network, follow these steps from a Windows system:

- From a Windows system, right click on My Computer, and click on “Map network drive ...”
- Provide the dna server IP address and share name.
  (See next screenshot)

**Mac:** To access the administrator dropbox over the network, follow these steps from a Mac:

- From a Mac system on the network, open Finder.
- Click on Go->Connect to server (see next screenshot).
- Login as Guest
- Connect to the admindropbox volume ONLY
AccessDNA is an application that is installed automatically when you install a DNAevolution client or a Mac based archive manager. AccessDNA provides a DNAevolution client access to certain key attributes, such as:

+ Which specific folders should be exposed to the web interface
+ Which users are allowed to access these folders from the online web GUI
+ Which UNC drives should be accessible
+ If local hostnames and IPs should be reported to the online web GUI

GETTING TO ACCESSDNA

On a Mac, AccessDNA can be found under Applications->StorageDNA->accessDNA.app.

On a Windows PC, AccessDNA can be found under Programs->StorageDNA->AccessDNA.exe.
ENABLE FOLDER ACCESS

Only a user with physical access to the machine has ultimate authority over which folders to expose and to which users those folders are accessible in a DNAevolution environment. If “Restrict StorageDNA access to selected folders” is checked, then DNAevolution will restrict folders according to the rules set up by the user. If this checkbox is not enabled, all folders (including items hidden by operating systems) will be visible to the DNAevolution environment.

**TIP:** Folder restriction is also enforced when the job runs. So if a user does not have access, the job will be denied access to the folder.

Once restriction is enabled, you can make folders visible to the DNAevolution environment by adding them to the list. When you click the “Add” button, you can select the folder and decide if you would like to expose this folder to all DNAevolution users or to just select users and groups. You can edit and delete these entries when required.

ENABLE UNC DRIVES

AccessDNA requires you to explicitly add networked machines that you will access over UNC. This check is put in place to prevent unauthorized access to other computers in your networked environment. Check the “Enable UNC Support…” checkbox to enable UNC access for this machine. To configure UNC, click on Configure. After the configuration dialog is open, you can add UNC machines. To add a new machine, you can browse the network for machines or type in the UNC machine name. Optionally, you can add the network provider. Once you are done adding the UNC machines, you can add UNC paths in the folder access list.

**TIP:** (For Avid Unity/ISIS)

While setting up Unity/ISIS Connection Manager, the following information can be helpful:

- The username/password of a Windows box must exactly match the password provided for the username under the Connection Manager, OR the username should be entirely different.
- To find the Unity/ISIS system name that you will need to provide in AccessDNA:
  In Windows, under My Computer, you will see the workspace listed as projects under a Unity/ISIS server name. Use that name as the server name for AccessDNA.

VIEW AND RESTART SERVICES

You can view and restart essential DNAevolution client services from this menu. If your client machine is not browsable or is unable to sync jobs, it is a good idea to restart client services via this menu option.

ENABLE CLIENT LOGGING

You can enable or disable client logging for debugging purposes. This is an advanced option and should be used under guidance from a StorageDNA support professional.
Previews (often referred to as Proxies) are web-playable low-resolution video files that correlate directly to the original full resolution files that have been archived to LTO using DNAevolution. DNAevolution can automatically link the preview files to their corresponding high-resolution clips archived on LTO.

DNAevolution DOES NOT provide functionality for creating previews, but can link to previews created by a third-party transcoder. The DNAevolution controller can be configured to point to a folder (local or networked) where the previews are located. DNAevolution automatically indexes the previews folder at a scheduled interval to find any newly added previews.

**PREVIEW NAMING AND FOLDER REQUIREMENTS**

DNAevolution uses the following heuristic for linking high-resolution media with low-resolution clips in the Previews folder. (NOTE: Previews are available only in the Search Clip tab via the Clip Info button)

When you select a clip in the Clip view, DNAevolution looks at the high-resolution filename on the LTO tape. (For clips that have multiple files, (e.g. P2, XDCAM), DNAevolution looks for a preview file with the name of the video track of that clip.

The preview filename must have a partial name match with the clip’s filename. For example, if the high-resolution file is called Demo-Movie.MXF, then DNAevolution will match that with any preview filename with the format `<filename>-<low res name>.extension`. So in this example, DNAevolution will match on any of the following Demo-Movie-web.mpeg4, Demo-Movie-preview.MOV, etc.

The preview folder can have any hierarchical structure. DNAevolution indexes the entire structure and finds previews.

**GENERATING PREVIEWS**

Previews should be generated by a third-party transcoder. They are played using the embedded HTML-5 player in the browser. As such, any preview created must be playable by HTML-5 FlowPlayer.

Refer to the document “DNAevolution 3.5: Workflow Guide for Automated Third-party Preview Generation” for steps on configuring a third-party transcoder for automated preview generation.
CONFIGURING THE PREVIEWS FOLDER

Previews can be configured from the “System Settings -> Setup Previews” tab.

+ Previews can be created on any network share as long as they follow the Preview Naming and Folder Requirements.
+ To connect the DNAevolution Controller Server to the Preview folder, click on Connect.
+ Here you can provide an IP/hostname and other details to connect to the Preview share. (See the next section “Mounting Network Shares” for detailed steps).
+ Once connected, DNAevolution Controller will periodically index the Previews.
+ At the bottom of the page, you can see the last indexed time (shown in next screenshot).
MOUNTING NETWORK SHARES

DNAevolution allows network shares to be mounted from the web interface. To mount network shares, follow these steps:

- Browse to System Settings -> Network Shares
- Click on “Add”
- Select from the following options.

Network shares can be mounted via the web interface. This is however possible only for Linux controller machines

- A new row will be added (See below)

- Click on each cell and update each entry as needed.
- Once done, click on “Check Mounts”.
- Once mounted, a share will highlight in green.
- To disconnect a share, select the share and click on “Disconnect”.

CONFIGURING CATALOG BACKUPS

DNAevolution maintains an XML-based catalog of all file metadata. This catalog is backed up to a USB key attached to the DNAevolution server. However, this catalog can be automatically backed up to a second location. This second location can be any network share. The backup share can be configured from the “System Settings->Manage Backups” tab.

- To connect the DNAevolution Controller Server to a network folder for backups, click on Connect
- Here you can provide an IP/hostname and other details to connect to the Backup share.
- Once connected, DNAevolution Controller will periodically backup the catalog.
- At the bottom of the page, you can see the last backup time.
CONFIGURING EMAIL

DNAevolution allows an administrator to set an email server for outgoing emails for alerts. To configure the email server, browse to “System Settings -> Email”. Configure the email server using the provided fields (see next screenshot). Please refer to your internal IT department or StorageDNA support for setting up your mail server.

CREATE, EDIT, PREVIEW METADATA TAGGING TEMPLATES

DNAevolution allows for the creation of advanced metadata tagging templates. Tagging templates in DNAevolution have the following features:

+ Ability to create unlimited key-value pairs
+ Ability to create unlimited headings
+ Ability to create fields of types date, description, string, dropdown, numeric

To create, edit or preview the metadata tagging templates, perform the following:

+ Login as an Admin User (template creation and editing is only available to Admin Users)
+ In the Archive Settings Tab of any archive, click on the “Create/Manage template” button.
+ The Add/Edit/Preview metadata page will open.

Create/Add new template:

+ Click on the “Add” tab. Type your template name.
+ You can select from a number of different fields to add (See next screenshot).

+ After adding the fields, click on Create Template.

Update existing template:

+ Click on the “Update“ tab. Select the template from the dropdown.
+ You can add new fields by clicking on the different types OR you can update existing fields by selecting them from the row
Remove existing template:
+ Click on the “Remove” tab. Select the template from the dropdown.
+ A preview will be generated. You can then review and delete your template.

Preview existing template:
+ Click on the “Preview” tab. Select the template from the dropdown.
+ A preview will be generated.

NORMAL AND LIMITED USER METADATA TAGGING

Normal and Limited users of DNAevolution can add metadata based on the custom templates created by Administrators of the system.

+ Log in as Normal or Limited user.
+ When in the Clip Info view, choose the “+ Metadata” button.

The next popup will allow you to select from a dropdown of templates. Select the template to be used (See next screenshot)

+ Fill in the appropriate information into the template and click on “Save Data”.
+ The new metadata is added to the clip.
+ Multiple items can be selected for metadata tagging by multi-selecting items in the Clip Search tab, then choosing the “Tag” button
SETUP AUTOMATED PREVIEW CREATION

DNAevolution can be configured to auto-generate previews. DNAevolution relies on a third-party transcoder to create previews and auto-indexes the previews for display in the web. Please refer to the document “DNAevolution 3.5: Workflow Guide for Automated Third-party Preview Generation”.

MANUALLY INDEXING PREVIEWS

Often times it may be necessary to have the preview indexer run right away rather than wait to index files on the 1 hour interval (e.g. during a demo). In such cases, it is possible to run the preview indexer on-demand. To run the preview indexer, follow these steps: Go to the DNA Controller Desktop (see next screenshot).

Run the script “gen_previews.sh” by double-clicking on the desktop shortcut and choose -> Run in terminal. This will index all the previews.
LTO/LTFS TAPE MANAGEMENT

DNAevolution enables the management of LTO tapes. Operations supported are Format, Mount, Unmount, Move, Verify, Import and Duplicate.

NOTE: All operations can be performed directly using the web interface except the Import function.

LOADING LOCK (AUTOLOADERS ONLY)

Loader locking is a software lock designed to protect the system from resulting in a state where there is a difference in the hardware inventory/tape map and software inventory/tape map. This can happen if the loader trays are opened and closed when a software tape operation is about to occur.

To enable a software lock, click the “lock” button found on the Clients Tab -> Tape Devices -> View Autoloaders view page.

**TIP:** Loading tapes via the Mail slot, Un-loading tapes etc? USE THE LOADER LOCK

An unlocked autoloader will have the following UNLOCKED icon displayed (See below)

![Unlocked Autoloader](image)

Click the Lock button, to lock the loader. Once locked, the following message will display (See below).

![Locked Autoloader](image)

Once the loader is locked please note of the following:

- **Any operation requiring a loader lock (e.g. job runs, verifications, duplications, tape movement etc.) will all result in a queued operation until the loader is UNLOCKED**

- **When the loader is lock is taken, the “View Loader” page will not refresh until the loader lock is released. This is because the page itself takes a lock on the loader**

MOUNT, UNMOUNT

Mount and unmounts ltfs mounts a tape. The tape must be loaded in the drive for the mount to succeed. To load a tape into a drive, either manually load the tape (single drive) or move the tape into a drive (autoloader). Steps on how to move a tape into the autoloader drive are covered in the “Move” section.
MOVE (AUTOLOADERS ONLY)

The Move operation allows you to use the autoloader robot to manually move a tape into a drive or move a tape from a drive back to its slot. To move a tape, follow these steps:

- Browse to Clients. Select the Archive Manager that the loader is connected to. Select the “Tape Devices” tab.
- Select one of the drives and click on “View Loader”.
- The autoloader screen will appear where you will be able to move tapes.
- To move a tape from a slot to a drive, select the tape from the slot. Then select the drive from the drop down (See screenshot below). Then click on Load Tape.

- To move a tape from a drive to a slot, select the drive from the drop down (See screenshot above) and click on Unload Tape. The autoloader keeps track of which tape resides in which slot and automatically moves the tape back to its original slot.

FORMAT TAPES

DNAevolution allows you to format one or more tapes (in case you have an autoloader) in a single operation. Formatting a tape performs the following operations:

- Loads the tape into a drive (in case you have an autoloader)
- Ensures the tape does not already exist in the DNAevolution catalog
- Performs an LTFS format on the tape
- Registers the tape into the DNAevolution system

**TIP:** Speed up formatting by setting up format on multiple drives at the same time.

To format one or more tapes, perform the following:

- **STEP 1:** Browse to My Clients -> Select the archive manager -> Click on Tape Devices tab
- **STEP 2:** Select the drive you want to use to perform the formatting.
- **STEP 3:** Click on the Format button. The format screen will open (See next screenshot).
+ **STEP 4**: Click on Add. You will see a candidate list of tapes that are eligible for formatting. You can use the tape filter to narrow the list of tapes. (See next screenshot)

+ **STEP 5**: Select the tapes you wish to format. Check the Force Format box if the tapes were previously formatted in DNAevolution (or other solution using LTFS)

+ **STEP 6**: Select Clear catalog if you wish that corresponding catalog entries in an archive be deleted during a format.

**Force format will result in completely overwriting the previous LTFS index and all data on that tape.**

+ DNAevolution will load each tape into the drive (in case of an autoloader) and format each tape sequentially.

+ Tape format results can be viewed in the AdminDropbox. (See next screenshot)
DNAevolution enables you to verify media on one or more tapes. Verification is performed at a number of levels to ensure media is safe. Verification performs the following checks:

- LTFSCK of your tape to ensure that the LTFS volume is consistent
- LTFS mount to ensure it mounts successfully
- File listing on the LTO tape to ensure it matches with the catalog (DNAevolution keeps a list of all files on tape)
- Reads every file back and runs a full MD5 checksum. Compares it to the original MD5 checksum recorded in the catalog (DNAevolution computes the checksum of every file archived to LTO)

Follow these steps to verify your tape:

**STEP 1:**
- Make sure all tapes you are verifying are write-protected. (See next image)
STEP 2:
+ Load the tape into a single drive or load them into the autoloader slots

Ensure that NO TAPES are loaded in the autoloader drives and are residing in their original slots. Loading tapes into a slot that was previously occupied by a tape in a drive can cause the autoloader to malfunction.

STEP 3:
+ Browse to the “My Clients” tab. Select the archive manager and the “Tape Devices” tab. Select the drive that you want to use to verify your tapes.

STEP 4:
+ Click on “Verify”

STEP 5:
+ The verify screen will open (See next screenshot).
STEP 6:
+ If using an autoloader, the verification screen allows for multiple tapes in the autoloader to be verified sequentially. If using a drive, your tape and drive will be pre-filled.

STEP 7:
+ To add multiple tapes in an autoloader, click on Add.

STEP 8:
Advanced options allows you to set the following options:
+ Catalog Removal: The verification will auto-remove catalog entries of files that have failed checksums. Once this is performed, the archive job can simply be re-run to pick-up the failed files.

STEP 9:
+ The tapes selection screen will open (See next screenshot). Here you will see a list of all tapes that are eligible for verification. You can use the tape filter to further narrow down your tapes list.

STEP 10:
+ After you have added your tapes, click Start Tape Verify. DNAevolution will start verifying your first tape and then automatically load the other tapes (if an autoloader). The results can be found in AdminDropbox/Validate Tape Reports/Tape ID. A number of files will be present (See next screenshot).
STEP 11:

DNAevolution creates a log for the ltfsck check and checksum logs for each archive and the files on the tape. In this example, “tapevalidate-DNA603-20-may-UTF-report” is the verification report for the archive “may-UTF” on tape DNA603 (See next screenshot). Additionally, you will find a “foundfiles.out” (in this sample, the file is called “20-may-UTF-foundfiles.out”) which contains a list of all files found for this archive on the tape. The file “tapevalidate-DNA603-20-may-UTF-failed.log” is a list of all files that failed verification. The xml file is for display purposes internal to DNAevolution.

To ensure your tapes are verified correctly, the ltfsck log should be successful and there should be no Failed logs. If there are failures, please save the logs and contact StorageDNA support for assistance.

AUTO-VERIFY TAPES

DNAevolution enables you to auto-verify full tapes. This is done by dedicating one or more drives to verification. Additionally, tape filters can be provided allowing the auto-verify process to only match on the selected, full tapes. Auto-verification can also be setup on a schedule.

As tapes are marked full, the auto-verification engine wakes up and picks up (via the filter) any new, full tapes that have not as of yet been verified.
Follow these steps to setup auto-verification:

1. Browse to and select the tape drive that you wish to use for auto-verification. This can be done by browsing to Clients -> Select the client machine -> Select the drive
2. Then click on “Verify”
3. There will be an additional option now at the bottom, called “Auto Verify” (see screenshot below)

The Auto-Verify screen will open that allows you to setup auto-verify. (see screenshot below)

The following can be setup:

- The time of day when the auto-verification will run.
- An optional tape filter based on which tapes will be selected for verification. Tapes via a comma delimited list or tape filters via a “*” (e.g. AYX* or simply *) can also be specified. This allows drives to be dedicated to tape groups.
- Finally, a username and password must be specified to schedule the auto-verify job.

**DUPLECTATING TAPES**

Duplication is a critical addition to ensuring your content is safe. You need a minimum of 2 LTO drives to create a duplicate tape.

**TIP:** Before duplicating a tape, ensure the source tape is (a) Marked as full (b) Successfully verified and (c) Write lock is enabled. Ensure the target tape is (a) In the autoloader/drive (b) Has a barcode (should be a unique barcode and not the same as the source tape) (c) Formatted LTFS and part of the DNAevolution system.
DNAevolution enables you to make duplicate (second) copies of your LTO tapes. Duplication allows you to keep a second copy at an offsite location ensuring that two copies of your data exist in two locations. Duplication will perform the following steps:

+ Load source tape and target tape into separate LTO drives.

To duplicate a tape, perform the following:

**STEP 1:**
+ Browse to My Clients -> Select the archive manager -> Click on Tape Devices tab.

**STEP 2:**
+ Select the source drive you want to use to perform the duplication.

**STEP 3:**
+ After selecting the source drive, click on “Duplicate”

**STEP 4:**
+ The Duplication Settings screen will open (See screenshot below).

For Autoloader configs, ensure there are no tapes loaded in LTO drives. If you have a standalone drive, then ensure your source tape (that you want to duplicate) is loaded in the source drive.
STEP 5:
+ The Duplication Settings screen contains a grid of two columns for source and target tapes. You must first select your source tapes. To select source tapes, click on Add …

STEP 6:
+ The Tape List screen will open. The screen will show all tapes that are a candidate for duplication. (See screenshot below)

STEP 7:
+ Select the tapes you wish to duplicate.

Ensure there are available (formatted, part of the system and have zero bytes used) tapes in the autoloader. There should be as many tapes as you have selected to duplicate.

STEP 8:
+ Once you have selected all the source tapes, you must select a target for each source tape. To select a target, click on target cell for each source tape and select the target tape from the dropdown. (Screenshot below)

STEP 9:
+ Click on Start to begin the automated duplication process.
DNAevolution supports importing LTO/LTFS tapes created by third-party applications. Tapes MUST BE formatted LTFS in order for DNAevolution to be able to import them.

The bulk import tool enables LTO/LTFS tapes written by third-party software (OR) LTO/LTFS tapes written by another DNAevolution system to be imported (please see the tips below).

Tape import works in the following manner:

- LTO/LTFS tapes written by third-party and other DNAevolution systems can now be used within DNAevolution.
- When a third-party LTO/LTFS tape is imported into an archive, its file-system structure is read from the tape and a catalog structure is created under its tape ID. After this process, the data on tape can be searched as if the tape was archived using DNAevolution.
- You MUST import using the “checksum” option to be able to run a verification on these tapes, which could take substantially longer than importing without the “checksum” option, so please plan accordingly.
- When an LTO/LTFS tape written by another DNAevolution system is imported into an archive, its file-system structure is read from the tape and a catalog structure is created exactly as if it was created on that system. After this process, the data on tape can be searched as if the tape was archived on that system. However, as in the previous case, you MUST import using the “checksum” option to be able to run verification on these tapes.

Tape import can be run via the web or via command line. Web import steps can be found in the next section (here) while import via cmd line can be found here (here).

**WEB IMPORT**

Tape import can be run via the web interface. The tape import can be found at the following location:

Select Clients -> Pick the archive manager -> Select the drive -> Click on Import (Screenshot below)
Once, Import is clicked, the import page will open (Screenshot below).

On the Import screen, you will need to select the following options:

+ The Client Machine and Tape Device will be pre-selected
+ Select the Archive Name for the target archive you wish to import these tapes.
+ Click on Add. A list of tapes will display.

**NOTE:** Only tapes that are NOT in the DNAEvolution database will be displayed.

+ Select the tapes you wish to import.
+ Click the Start Tape Import to begin the process.

**Web import DOES NOT perform a checksum. You must use the command line tool if you wish for checksums to be performed on import.**
COMMAND LINE IMPORT

Tape tools are accessible via command line (Terminal access) on each archive manager. Tape tools cannot be run from an archive client.

On Mac (Must be logged in as SUDO user):
+ Open Terminal
+ "cd /Applications/StorageDNA/accessDNA.app/Contents/MacOS/"
+ Here you will find tape_validate (bulk verify tool), format_changer (bulk format tool), ltfs_import (bulk import tool), ltfs_copy (bulk duplicate tool)
+ **NOTE:** All operations (except tape import) can be run directly from the web interface.

On Linux:
+ Open Terminal on desktop or ssh to serv
+ "cd /opt/sdna/bin"
+ Here you will find tape_validate (bulk verify tool), format_changer (bulk format tool), ltfs_import (bulk import tool), ltfs_copy (bulk duplicate tool)
+ **NOTE:** All operations (except tape import) can be run directly from the web interface.

To run tape import on a tape written by DNAevolution, follow these steps:
+ Locate the bulk import script based on the instructions in Section: Location of Command Line Tape Tools.
+ Once in the scripts directory, type "./ltfs_import" for instructions on how to run the bulk import
+ Examples:
  ./ltfs_import -archive "Nov13-sdna-tape-import-test" -source st1 -serials DNA603 –checksum
  • The above command will import a DNAevolution tape into the archive named Nov13-sdna-tape-import-test and will also compute the checksums of the files.
  (See next screenshot: archive after import.) Omit the–checksum flag if you do not want checksums computed.

To run tape import on a tape written by open LTFS tools or third-party LTFS archiving software, follow these steps:
+ Locate the bulk import script based on the instructions in Section: Location of Command Line Tape Tools
+ Once in the scripts directory, type "./ltfs_import" for instructions on how to run the bulk import
Examples:
```
./ltfs_import -archive "Nov13-nonsdna-import-test" -source st1 -serials DNA603 –checksum
```
- The above command will import a third-party tape into the archive named Nov13-nonsdna-import-test and will also compute the checksums of the files. (See screenshot: archive after import.) Omit the –checksum flag if you do not want checksums computed.

Checksum during import will dramatically increase time to import (as every file has to be read from tape) versus non-checksum where only the file-system index from LTFS is read. However, if you do not enable checksum, you cannot verify these tapes.

VIEWING TAPES AND UTILIZATION, ADDING NOTES

All tapes in your environment are listed in the “Tapes” tab (See next screenshot).

TAPE ONLINE/OFFLINE INDICATOR

Every tape in the MyTapes page will appear in bold green if the tape is present in an auto-loader. If not present, it will appear in italicized grey.

Tape online/offline indicator is supported only in autoloaders. Also you MUST initiate a tape move either via a job or manually to have the tape online/offline list refresh. Adding new tapes in the loader without causing a tape movement from the DNAevolution will not refresh the list.
TAPE LISTING
For every tape, you can select the tape and view, and, for certain options, edit the following:

**Tape Serial:** This cannot be edited and is the LTFS volume name, tape serial number, and bar code of the tape.

**Tape Location and Notes:** Here you can specify where your tape is currently physically located.

**Tape Capacity:** Every tape provides a visual clue as to how much space is left on it. Upon selecting the tape, you get a more detailed view of the total space on the tape and how much is remaining.

Full capacity of LTO Tapes will not be available for use. This is due to LTFS metadata and an extra buffer maintained by DNAevolution to ensure smooth LTFS file-system operation.

**Tape History Log:** This table allows you to add log notes on a per-tape basis.

DELETING TAPES
DNAevolution allows you to delete a tape. To delete a tape:

**STEP 1:**
+ Browse to My Tapes

**STEP 2:**
+ Select the tape you wish to delete and click on the icon

Deleting a tape simply removes it from the list of tapes in the DNAevolution tapes list. It does not remove the archive catalog entries (catalogs can be deleted during a format, see below). And it does not remove any data from the tape. The tape must be Force Formatted for all data to be removed.

**STEP 3:**
+ Once a tape has been deleted from the database, its corresponding catalog entries can be deleted during a format. On the format screen, an option Clear catalogs automatically deletes catalog entries on the tape. **NOTE:** Force Format must also be checked.

GENERATING REPORTS
DNAevolution allows multiple reports to be automatically generated. These reports can be accessed via the Reports tab on the main screen. (See next screenshot)
DNAevolution allows a number of different types of reports to be generated. All reports are generated into the administrator dropbox in a folder called reports. This is accessible via a report viewer (accessible by clicking the “View report logs” button) or by connection over the network share and viewing it via a Text editor.

The following is a list and description of each report type.

**Archive Files Reports**

- **List files on Archive**: This report generates a list of all files in the archive along with their checksums, archived time, modified time. This is generated in a csv format giving you the ability to manipulate, generate graphs directly in excel if needed.
- **Archive summary**: This report generates an archive summary for all archives. For each archive the following details (shown below) are provided. The summary is stored in a csv giving you the ability to manipulate, generate graphs directly in excel if needed.

```
filename, size, last modified time, checksum, write time into archive, tape serial
```

**Tape Reports**

- **List of files on Tape**: Often times it becomes necessary to have a list of files on tape. This report creates a list of files on each tape by archive. This is generated in a csv format giving you the ability to manipulate, generate graphs directly in excel if needed.
**Tape summary**: This report generates a tape summary for all tapes. For each tape the following details (shown below) are provided. The summary is stored in a csv giving you the ability to manipulate, generate graphs directly in excel if needed.

![Tape summary screenshot]

**Job Reports**:
- **Jobs failed**: This report gives a list of all jobs that have failed in a particular time period.
- **Jobs succeeded**: This report gives a list of all jobs that have succeeded in a particular time period.
- **Jobs with warnings**: This report gives a list of all jobs that have failed in a particular time period.

The reports can be run automatically every night at mid-night or instantly. The report notification can also be sent via email.

**VIEWING REPORTS**

Reports generated are placed in the administrator dropbox and can be viewed from the web. To view reports, click on the “View Report Logs” button at the bottom of the page. The report viewer will open. (See screenshot below).

![Report viewer screenshot]

Reports are categorized by a top level date and time folder. Under that, you will see the reports you requested.
ARCHIVE MANAGERS AND SERVERS MANAGEMENT

All clients and servers are managed via the “Clients” tab. You can perform a number of operations on clients and servers.

THE CLIENTS VIEW

On the “Clients” main tab, you will see a list of all clients and servers in your environment. You can perform the following actions via the action toolbar to the left of the clients listing:

For each client, you can edit and view information in the following sub-tabs:

+ General Information
+ Point-to-Point Connectivity
+ Tape Devices (if it is a server)

Each of the sections above is highlighted in more detail below. You can view but cannot edit the information under the License Information sub-tab. (The information in this sub-tab is discussed in detail in section: License Management.

GENERAL INFORMATION

In this section, you can see information about each client and server. Specifically, the following items need further explanation:

Client Machine Color: Black signifies a healthy archive client or archive manager machine that has an active connection to the DNA Server. Red signifies an archive client or archive manager machine that has lost connection due to networking issues or is not turned on. A Red machine cannot run jobs or be used for configuring jobs.

Client Name (Editable): This is purely used for visual identification purposes and has no effect on hostnames.
Default run as user (Editable): This is the default local username under whose credentials jobs will be created.

License Type: This signifies whether the system is an archive client or server. An archive client has the license type (LIC_CLIENT_ARCHIVECLIENT), and an archive manager has a license type (LIC_CLIENT_ARCHIVESERVER).

User/Group Access List: As an admin, you can add users/groups to the “Authorized Users” list for this client or server. If a user is not on this list, that user will not be able to view this system for archive or restore jobs.

POINT-TO-POINT CONNECTIVITY

This section is dedicated largely to configured network transfers for DNA Sync. It is not relevant to a DNAevolution configuration.

TAPE DEVICES

In this section, you can see a list of all tape hardware connected to the client or server. You will see only tape devices connected to archive managers. For standalone environments, you will see one or more tape drives connected.

You can perform LTFS operations directly on the tape currently inserted in the tape drive. To perform an operation on a tape, insert a tape in the drive. A list of allowable operations includes Mount/Unmount, Format, Verify, Duplicate. These are covered in the “LTO/LTFS Tapes Management” section of this guide.
DNAevolution allows you to create multiple users and groups in the web interface. As an admin, you can use users and groups to give different levels of access to different users. You can decide which clients and servers a user or group has access to and which folders on a client machine are accessible to a user.

### ADDING, EDITING, DELETING USERS

The “Users” tab allows you to add and edit users. To add a user, click on the “Add/Plus” icon in the action toolbar. Fill in the required information about the user. You also will be required to select the role type.

An **admin user** will be able to see all aspects of the system.

A **normal user** will be able to see only the client machines, servers, archives, jobs that they created, and any groups to which they belong.

A **limited user** will only be able to see the client machines, servers and archives that they have been included in, but they cannot create, run or perform any function beyond browsing and searching within the assigned archive(s).

To delete a user, simply select the user and click on the “Delete/Minus” icon.

Additionally, as an admin, you can add a user to, or remove one from, any groups from this screen.
The “Groups” tab allows you to add and edit groups. To add a group, click on the “Add” icon in the action toolbar. Fill in the required information about the group (name and description).

To delete a group, simply select the group and click on the “Minus” icon.

Additionally, as an admin, you can add a user to, or remove one from, any groups from this screen.

NORMAL USER WORKFLOW

Normal user workflows allow an organization to create users that can perform all the operations of archive, search and restore but are limited to certain archives, client machines (Archive clients or managers) and also to certain folders and volumes on the client machines. A typical workflow would be:

**STEP 1:**
+ Create a normal user

**STEP 2:**
+ Assign an archive manager and/or client to the normal user

**STEP 3:**
+ Normal user can now login and create their own archives
GROUP WORKFLOW

Group Workflows allow an organization to create archives and client machines (archive managers and clients) under a group, which enables any user who belongs to that group to have access to those archives and clients. A typical workflow would be:

**STEP 1:**
+ Create a group

**STEP 2:**
+ Assign one or more users to that group

**STEP 3:**
+ Assign an archive manager or client to that group

**STEP 4:**
+ Create an archive with group access

**STEP 5:**
+ Now all users in that group will have access to both the archive and client machines
LICENSE MANAGEMENT

Machines that have DNAevolution client software installed are administered via the Clients -> License Information sub-tab on the web management console. DNAevolution enables you to manage licenses if you are the assigned owner of the license. If you do not see any licenses, it means you have not been assigned any licenses.

LICENSE USAGE AND POLICY

All DNAevolution licenses are assigned by default and owned by the “admin” user. Only the user who is the owner of a license ("admin" user by default) can see the licenses in the Clients -> License Information sub-tab. If you need licenses assigned to another user, you need to advise your reseller and/or StorageDNA at time of purchase.

Upon client software installation using a license key, the client machine by default will appear only for the "admin." The “admin” user will need to assign the machine to a normal user before the normal user can create syncs to and from the installed machine.

LICENSE LISTING

All licenses are listed under the Clients -> License Information sub-tab. Use the following key for licenses:

- **Black**: Assigned valid license
- **Green**: Available and unassigned license
- **Red**: Expired license

TO ADD A USER TO A MACHINE

After installation, you may want to give another user access to use that client for archive and restore operations. First, browse to the “Clients” tab. In the “General Information” section, you can add users to the authorized users list. Add the user you would like to give access and save. Now the normal user will be able to use the client machine for DNAevolution functions such as archive and restore.

TO REMOVE/UNINSTALL A CLIENT MACHINE AND RECLAIM THE LICENSE

When a client machine is uninstalled, the associated license key will be reclaimed. Additionally, you can simply delete a machine from the client list. This has the same effect in returning the license to the available pool.
UPGRADING DNAEVOLUTION CONTROLLER, ARCHIVE MANAGER, ARCHIVE CLIENT

The following section guides you through the process of upgrading the DNAevolution Controller, Archive Manager, and Archive Client.

UPGRADING DNAEVOLUTION CONTROLLER AND LINUX ARCHIVE MANAGER

The following section has instructions on how to perform a controller and archive manager upgrade on the Linux server.

STEP 1: Download and copy the upgrade package.
+
The upgrade package can be downloaded from the upgrade email sent out with every release. Download the upgrade package to a machine that can mount the ADMINSTRATOR DROPBOX network share. (See section: Network Connecting to the DNA Server Administrator Dropbox.)
+
The upgrade file will be a .run file (e.g. DNAEvolution-v3.5-8ZZZ.run) where the updater has the following format <PRODUCT NAME>-RELEASE-BUILD
   • Copy the .run upgrader package to the following directory:
      – ADMINDROPBOX/Updates (see screenshot)

STEP 2: Run the updater
+
Login to the DNA Controller via terminal OR login via a keyboard, monitor and mouse
+
On the desktop, run the script “update-server” by double-clicking on its desktop shortcut
+
Upon running the script, you will see a menu to update the server (see next screenshot)
Select “Update Evolution Server”
You should see the updater package you copied to the “Updates” folder
Select the package using “space bar” (see next screenshot)

Select OK to start the upgrade process. The upgrade process will take some time to run
After completion, exit the menu

UPGRADING ARCHIVE MANAGER AND ARCHIVE CLIENT

TIP: The Linux archive manager running on the central controller is auto-updated as part of the controller upgrade process, while configurations with Mac-based Archive Managers will require extra steps

To upgrade archive clients or archive managers NOT running on the controller machine, you must download the installers from the DNAevolution web interface (similar to running an install from scratch). Follow the same steps in section: DNAevolution Mac Archive Manager Setup and section: DNAevolution Archive Client Setup. Choose the “Upgrade” option when running the client installers.
DNAevolution can export metadata from an archive. An archive’s metadata export is a zip file. Upon opening the zip file, you will find a file-system that looks exactly like the archive. Every filename matches the filename archived to LTO. However, in this case, the file is an XML file. Each file contains all the metadata that is extracted and indexed by DNAevolution. Here is a sample metadata XML file:

```xml
<file type="file">
  <filename><![CDATA[Avid_Mob.0A01.4FD88B4FD8B4B3.mxf]]></filename>
  <proxy-path><![CDATA[000 - Avid MediaFiles/1/Volumes/JupiterEnt p2 test/Avid MediaFiles/MXF/1]]></proxy-path>
  <source-path><![CDATA[/Volumes/Avid MediaFiles/MXF/1]]></source-path>
  <archive-name><![CDATA[000 - Avid MediaFiles]]></archive-name>
  <clip-name><![CDATA[SO-20120118-A02.23 0024FR.new.01]]></clip-name>
  <actions>
    <action version="1" size="365153" mod-time="1339602100" run="20120628-093651"
           checksum="08db823c9f941a6d83a5a82ab32b0111" write-time="1340901430" write-index="8" type="upd"
           tapeid="AYX407" />
  </actions>
</file>
```

Currently, the XML contains basic file information including the checksum and tapeid it is stored on. The exported XML file serves as a metadata backup that can be used in the following ways:

+ Way to offload an old archive from a DNAevolution server to make space for newer archives
+ Way to move an archive from one DNAevolution server to another
  (NOTE: Archives can be exported and imported)
+ Way to move metadata to another third-party system, such as an asset management system

**HOW TO EXPORT AN ARCHIVE**

To export an archive, select the archive you wish to export. Then click the “Export” icon in the main action area (shown below).
Upon exporting the archive, a success message should appear (shown below).

The archive export process runs at specific timed intervals and can take a few minutes to complete.

You can then browse to the zip file in the Admin Dropbox and download the zip file (shown below).

Zip files are named with the following convention sdnaexport<Archive name>-<timestamp>.zip. Download the zip file by selecting the file and clicking the download button (shown below).

HOW TO IMPORT AN ARCHIVE

An archive can be imported back into the same DNAevolution controller or it can be imported into another DNAevolution controller. The import will bring in the relevant tapes, create and populate the archive.

To import, first you will need to copy the zip file to the DNAevolution controller Dropbox. You can do this by connecting to the Admin dropbox network share. (refer to previous Instructions) The file can be copied into the base directory or you can create a sub-directory. After you have copied the zip file, follow these steps:
Browse to the Admin Dropbox.
Select the archive zip file.
Click the Import button
Upon successfully importing the archive, it should appear in your archive list and you should be able to browse its contents like any other archive.

The archive import process runs at specific timed intervals and can take a few minutes to complete.
DNAevolution now presents live system monitoring for Linux archive managers and controllers. The system monitoring screen provides live statistics across various system components including memory, CPU, hard drives, connected tape hardware, Ethernet etc. The settings allow for a system administrator or StorageDNA support rep to quickly diagnose hardware related issues.

To view the live statistics, browse to Clients->Select the appropriate archive manager/controller->Logging & Statistics. Then click on Show System Stats. The following page will open. (See screenshot will open).

The above screen shows a large amount of information across various metrics

SEE RUNNING PROCESSES (CURRENT OR AT A PREVIOUS POINT IN TIME)

The top right corner of the screen allows you to quickly see the state of the system and running processes currently. To do so, simply click on the icon in the top right. (See screenshot below)
Click on any of the processes to get a more detailed view. (See detailed process section)

**SEE DETAILED PROCESS VIEW, INSTALLED SW AND CONNECTED DEVICES**

It is possible from the “quick process” view screen or by clicking on any data point in any graph to arrive at the detailed system process view page. (See screenshot below).
SEE SYSTEM LOAD

System load provides quick and valuable information into your system’s overall health to process requests. System load should be considered along with the number of CPU cores currently available in the system. E.g. a load of 4 is acceptable for a system with 4 total cores of CPU. Use the following as a rule for healthy system load:

\[
\text{Healthy Load} = \text{Total number of cores} + 2
\]

For systems running a non healthy system load, click on the graph at the point in time, the CPU load appears high. This will provide you a detailed process list. From this list you can see the various processes that might be contributing to high system load.

Additionally, graphs can be turned on and off by clicking on the key in the lower part of the graph.

SEE DISK STATISTICS

System monitoring provides a view into all disk partitions and their general health. On most systems, only a single system drive partitions exist but some systems have a separate disk partition for system versus index drives.

The system collects information across numerous disk statistics including Reads/sec, Writes/sec, Average Queue Size, Service Time and Utilization %.

Graphs can be turned on and off by clicking on the key in the lower part of the graph.

SEE MEMORY STATISTICS

System monitoring provides a view into all disk partitions and their general health. On most systems, only a single system drive partitions exist but some systems have a separate disk partition for system versus index drives.

The system collects information across numerous disk statistics including Reads/sec, Writes/sec, Average Queue Size, Service Time and Utilization %.

Graphs can be turned on and off by clicking on the key in the lower part of the graph.

SEE CPU UTILIZATION

System monitoring provides a view into CPU utilization across user space and kernel space.

Graphs can be turned on and off by clicking on the key in the lower part of the graph.
DNAevolution is equipped with a complete web based system logging and debugging tool. StorageDNA support, administrators and partners can utilize the tool.

**ENABLING SYSTEM LOGGING**

System logging can be enabled on a per archive manager/controller basis. To view the log settings screen, browse to Clients->Select the appropriate archive manager/controller->Logging & Statistics. Then click on Change Log Settings. The following page will open. (See screenshot will open).

<table>
<thead>
<tr>
<th>Sr. No</th>
<th>Process Name</th>
<th>Log Level</th>
<th>Log Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ClipsDNAExtract</td>
<td>Debug and Higher</td>
<td>Enable logging for issues with metadata extraction.</td>
</tr>
<tr>
<td>2</td>
<td>DeviceLockServer</td>
<td>No Logging</td>
<td>Enable logging for issues with device lock or device not available.</td>
</tr>
<tr>
<td>3</td>
<td>DNAITman</td>
<td>Debug and Higher</td>
<td>Enable logging for issues arising with any LTFS related operations (mount, unmount etc.) or device not available.</td>
</tr>
<tr>
<td>4</td>
<td>Indexer</td>
<td>No Logging</td>
<td>Enable logging for issues with indexing for search and metadata.</td>
</tr>
<tr>
<td>5</td>
<td>SchmidtJob</td>
<td>No Logging</td>
<td>Enable logging for issues with data movement, storage access, file permissions and device not available.</td>
</tr>
<tr>
<td>6</td>
<td>TapeChanger</td>
<td>Debug and Higher</td>
<td>Enable logging for issues with autoloader movement and device_not_available.</td>
</tr>
<tr>
<td>7</td>
<td>TapeDuplication</td>
<td>Debug and Higher</td>
<td>Enable logging for issues with duplicating tapes.</td>
</tr>
<tr>
<td>8</td>
<td>TapeImport</td>
<td>Debug and Higher</td>
<td>Enable logging for issues with importing tapes.</td>
</tr>
<tr>
<td>9</td>
<td>TapeVerification</td>
<td>Debug and Higher</td>
<td>Enable logging for issues with verifying tapes.</td>
</tr>
<tr>
<td>10</td>
<td>BulkTapeFormatter</td>
<td>Debug and Higher</td>
<td>Enable logging for issues with formatting tapes.</td>
</tr>
<tr>
<td>11</td>
<td>SchaiticketWatcher</td>
<td>Debug and Higher</td>
<td>Enable logging for issues with automated ticketing jobs.</td>
</tr>
<tr>
<td>12</td>
<td>Schainterviewway</td>
<td>Debug and Higher</td>
<td>Enable logging for issues with generating Interplay tickets via web services.</td>
</tr>
<tr>
<td>13</td>
<td>Schaitaskworker</td>
<td>Debug and Higher</td>
<td>Enable logging for issues with CatDV database updates.</td>
</tr>
<tr>
<td>14</td>
<td>EvoTicketProcessor</td>
<td>Debug and Higher</td>
<td>Enable logging for issues with tickets not converting.</td>
</tr>
<tr>
<td>15</td>
<td>SdhaAutoverify</td>
<td>Debug and Higher</td>
<td>Enable logging for issues with auto-verification setup, getting tapes for verification and calling verification on them.</td>
</tr>
<tr>
<td>16</td>
<td>LtsSmartAccess</td>
<td>Debug and Higher</td>
<td>undefined</td>
</tr>
<tr>
<td>17</td>
<td>TapeMigration</td>
<td>No Logging</td>
<td>Enable logging for issues with migration of archives/tapes.</td>
</tr>
<tr>
<td>18</td>
<td>AvidIndexer</td>
<td>No Logging</td>
<td>Enable logging for avid indexing script.</td>
</tr>
<tr>
<td>19</td>
<td>DnaLockScripter</td>
<td>No Logging</td>
<td>Enable logging for device lock script.</td>
</tr>
</tbody>
</table>
The system allows you to set log levels for various different underlying software modules. Once enabled, these modules will begin writing detailed logs.

Log outputs can be very detailed. Please turn off logging when done debugging.

**VIEWING SYSTEM LOGS**

System logging can be viewed by clicking on the “View Logs” button at the bottom of the page. (See screenshot below)
The top level folder displays the GUID of the archive managers/controller. All logs are maintained within each machine’s parent GUID folder. (See screenshot below)

For each module, logs can be viewed and for each log, the system displays the number of CRITICAL errors and WARNINGS enabling the user to quickly decide if a log should be further reviewed. (See screenshot below)

Each log can in turn be viewed and searched in detail. CRITICAL and WARNING are automatically highlighted as well (See screenshot below)
Logs can in turn be downloaded and sent to StorageDNA support for further analysis by clicking the download icon.

**ALERTS DASHBOARD**

DNAevolution features an Alerts Dashboard that provides alerts across the entire system. The Alerts dashboard can be found by clicking the Alerts button on any page (See screenshot below).

The following is an example of an Alerts dashboard.

Alerts can be filtered and deleted from this screen.

It is possible from the “quick process” view screen or by clicking on any data point in any graph to arrive at the detailed system process view page. (See screenshot below).